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Transitioning to OpenRoads Technology

* This presentation provides instructions for transitioning
standards and workflows and developing your
implementation plans. Learn how to utilize the exciting new
tools in SELECTseries 3 of the civil products. It is targeted for
all Bentley Civil users.

* At the end of this training session, an assessment will be
given. We will review all assessment questions and answers
to see what you have learned.
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Learning Objectives

After this session you will:
* understand how to run both SS2 and SS3 simultaneously.
» define which DGNLibs need upgrading.

* identify which resources need to be created new for SELECT
series 3
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OpenRoads is...

» the common technology for Bentley civil products that offers
iImmersive interaction of survey, corridor modeling, geometry,
terrain modeling, dynamic sections, and much more.

* immersive interaction of

— Survey

— Geometry

— Terrain modeling

— Corridor modeling

— Dynamic cross sections
— Civil cells

— Design intent

— Design-time visualization

OpenRoads
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SELECTseries 3 is....

intuitive design that exceeds civil engineering’s
rigorous demands, real-time 3-D modeling with instant
feedback that captures design intent and persistence,

all in DGN files.
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Bigger picture

SS2 files SS3 SS2 plan
production
Roadwa Terrain Geometry
y H & V Geometry —_—
Sit Design standards Surfaces
Ies Corridor definitions

Super Elevation

Curve Widening
Geometry Site modeling Profiles

3 Civil Cells PnP generator

Surfaces Dynamic profiles Labeling

Cross Sections Printing
Templates Evaluation & reports

Volumes
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SELECTseries 3

P startchd.dgn (2D - VB DGN] - Power nflosds Vi (SELECTseries 3) Fel-o-e
Be E& Seert Setnn Ids Suvey Sufacs Geomey Evakston Dranage Dfing Guanibes Fowerbfaacs Tods Ubes Wopace Wndow Heb
& - [resnccontoewcr] [ o ~ 0 v T~ Q 0 = |45 0 v igl NoFeaure Defrion
fy a] B-5-2-8-B-E-2-8-@-0Q48
[ XN & View3, Detoutt slE[=] %
Tasks = |, . R NEHS BB &L B =
e ek B-au- ARRNBEHHIDO D AR Ei
R i

Analysis & Reparting -
‘11 General Geometry n==a
L@t o = ViewS, Profile - CL-MAIN

Z 2

Grwv A% S NEBEODL 8 .

- | =

Harizantsl Geometry. -
BB yertical Geometry v
& Terrain Modeling v
Tl corndor Madeling -
12 30 Geometry - .

Crvil Meszage Center

¥ ooy Ve ) =

Gle Edt Hement Sstings Tools Survey Suface Geometry Evaluaon Drminage Drafting Quantiies Power inRoads Tools tities Workspace Window Help

@ - [0 | 200800490 5 g8 e Femes e CHef @ ¥/ 6

A [} HE-0-8-8-6- 2 R-B-0RIV

Tasks X P e DR O temmtiomatin (] = o] | 3|

Tasks - o STVCSCTT =g ) Teran Model Az

e rr— EERED G PEE R F st |3
2 Sorce Features Dispay g

5

B W,

ABELYLS

] corr dor Medeing

2 3D Geometry
= Civil Compenents
A survey

N Draving

¢le||k[<||<||<

4 visualization

Givil Message Center

8 Fom File b3k 2\chapter 24ar

R P—— '

O\ B w]

Pan View > Select Vew

[2l][sls

1y

o

A&

Cefaut

General
Information -~

Range High
Range Low,

4834 528.2971 58327.
4354.562.2793.801.0.3¢

10666
12
0
0
0
813
0
Numter of Brg 01
Numter of Tr 21.087
Edge Method 7
Edge Viethod Shivers
Calculated Features Display. -
Contaurs o
Trizngles
Triangle Vertizes on
Flow rrows off
Low Foints off
High Paints ot

o = {2 b Moo views = || T

21305 s -fe

Pan View » Select View

& [TRAFFICOONTDEVIC

 Terain Mocel: SURVEY, Trangls, Sevation 6.300n, Siope 42,54, Aspect 3

™+ Corridor Modeling Demo -Target Alias done.dgn [2D - V& DGN] - Power InRoads V8i (SELECTseries 3)

He Edt Eement Setings Drafting  Quantities

P a— T
st &

Tools Survey Suface

z0-|Z0 - |Qo -

Geomety Evalustion Drainage

Power InRoads Tools

s fe’\P No Feature Definition

(=

Uities  Workspace  Window  Help

Flet ®ulu 9 / B

HE-D-E-8-E-G-2-R-F -0 RUR

[

il |
Tasks

v FX a view1, Defauke

===l

Tasks

[# cwil Tools

ARQRBEY O BB N

HH Vertical Geometry
# Terrain Modeling

fll corridor Modeling

e §
W |t o

Rl o & i

VR

| 4 7 e
HENE e
£ U0 e T Y
A5
e 0 €6 €6 0, 1

Il e
s |2

W View 2, Default-3D

B~ A REHOWEE HTIE

[ sei0pdxgaosforg 2|

B View 3, Cross Section - Corridor: Hwy Plan: North_Bound Profile: N_PGL

[ View Propeties [~]| 1 < ]

264

262
260
258
256
254
252

£ 30 Geometry v
5 L4 252
b civil Components - s ).‘3' P e e s R S S I A L
A Survey il | -l < ] v « (| »
Civil Message Center
Q- © e [ muModsl Views +) EJ f LZFEI
R o & [Defat 3 5]

10

3

Bentley

Sustaining Infrastructure



SELECTseries 3
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What are Civil Cells

Civil Cells
* Build your own digital “Lego”

 Automate design processes
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Why Are CIVIL Cells Important?

Repeatable geometric modeling

— Organizations can create civil cells to reflect design standards

— User can re-use previously stored geometric configurations, but

adjust for project specific details
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Good News About Civil Cells

* Very powerful addition to Open Roads technology
« Sample libraries provided with installation package

» Best Practice:
— Keep it simple!
— Get familiar with Open Roads — geometry and corridor modeling
— Review standards to earmark potential candidates
— Poll users on usability and prioritize

=y Bentley
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Workshop Using Civil Cells

Wednesday 9:00am - 16:00
lan Rosam, Product Manager, BSW - Development, Civil Design
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Installation Considerations

SELECTSERIES 2 TO SELECTSERIES 3 OR BOTH?
— SELECTseries 3 dependency on MS 08.11.09.397

— Set-up / testing - Both can be loaded on same workstation
— Power products great alternative!

— Caution using resources in both versions
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Training Options

Convert SELECTseries 2
training - Just “picture
swapping”

No training — Not
recommended!

Successful SELECTseries3 Training =
Effective, Productive User

~— ;
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Resource Usage

Reuse:
— MS levels, fonts, cells, line styles
— Element templates Create:
- DGN L|brar|e§ — Element templates
— Survey TIW files — Graphical filters
- XIN, PSS, DDB, SMD (XML) — DGN libraries
— XSL style sheets (reporting) — Project settings
— Civil cells

Upgrade:
— Template library — add superelevation flag
— Design Standards — add vertical
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Lecture Understanding Features

Tuesday 13:30 —14:20
Ernst van Baar
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Design Standards - Review horizontal and vertical

Design Standards - validate local standards

P
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Vertical Design Standard -~
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Design Values -~
Speed 50 '
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Superelevation Standards

» SEP and SRL are supported.

* Superelevation tables — do
you have your standards
currently set up and in
production?

Q} Calculate Superelevation '?’ = |§1‘

Standards File Name C:\_demos\super\standards\SEP Standards‘\mndo[--]
e Selection High Speed v
L Selection 1:400 SF v
Design Speed 40 v
Transition ID Linear E]
Number Of Lanes 1 v
Facility Divided (=]
Open Editor B

[ Point Properties B2 |
"] Use Feature Name Overnide: |CL Close
Feature Definition: [ v]
(V] Superelevation Flag

Next >
—_— [ Hee |
Pavement
Constraints
Constraint 1 Constraint 2
Type: None - ] [ None N ]

[ Horizontal Feature Constraint:
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Workshop Superelevation in the OpenRoads Environment
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Tuesday 10:30-12:20 O'Clock
Maria Persson

=y Bentley



=== @
28 | WWW.BENTLEY.COM | © 2013 Bentley Systems, Incorporated 5 Be ntleg

Sustaining Infrastructure




Transitioning to SELECTseries 3
\

—— 2
29 | WWW.BENTLEY.COM | © 2013 Bentley Systems, Incorporated !. Be ntleg
S ure

wstaining Infrastruct

L



30

What is a MicroStation Workspace?

— A custom MicroStation environment or configuration.

— By selecting a defined workspace, you customize MicroStation for a

specific discipline, project, task, or standard.
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Civil Workspace

MicroStation
Settings |

Resources
Defaul ‘
t Configuration

values Variable

(Stroking L\ Definitions
Tolerances)

Pointers to
standards
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Advance Preparation - MicroStation

* Review current MicroStation resources — are they in
DGNLibs or can they go there? How are XIN, DDBs
and PSS affected?

* Development of MicroStation element templates and
graphical filters (such as for terrain models)

 Review CAD standards — changes due to Corridor
Modeling, geometry, use of reference files
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Advance Preparation - Civil

Review Design File Settings within Seed Files -
Determine default settings for Civil Formatting

Review Workspace Preferences — View Options > Civil
Review new configuration variables

Review new workflows and determine which areas may
be moved forward to new methods.

Are there any customized workflows that need to be
integrated?

Review reports; determine defaults, deficiencies
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Advance Preparation - Engineering

* Review horizontal and vertical design standards —
validate local standards.

 Superelevation tables
— Do you have your standards currently set up and in production?
— Do you follow Danish standards or use customized standards?

4 =y Bentley
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Considerations

» Has 3D corridor modeling started in earnest?
— Built in transitions, supers, target aliasing...
— IRD iIs not upward compatible

=y Bentley
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Advantages of Moving Ahead

« SELECTseries 3 the first release on the OpenRoads
technology — more to come!

* Slowly transition by project or functional group

» Great new tools for productivity enhancement!

=y Bentley
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Native Product Changes

 Roadway Designer modeling application removed and
replaced by OpenRoads modeling technology

» Removed Site Modeler commands / application —
superseded by OpenRoads modeling technology

» Roundabout tools removed and replaced by OpenRoads
technology

* Install procedure allows SELECTseries 3 to be installed
concurrently with SELECTseries 2.
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Native Product Changes - InRoads

* Cross section commands moved to OpenRoads
technology

* Improved integration between ProjectWise and the
geometry database (.ALG)

=y Bentley
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Native Product Changes - GEOPAK

» Corridor modeling application removed and replaced by
OpenRoads functionality.

* Ability to cut cross sections from a .DTM file was
removed from the Draw Cross Sections application.

* Improved integration between ProjectWise and the
geometry database (.GPK)

* Added new Cross Section Drawing, Earthwork and
Sheeting capability through the OpenRoads tools.
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BEYOND SELECTSERIES 3

PLANNING

[ SURVEY / MAPPING }

Immersive
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S
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)
P

CONSTRUCTION
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EVOLUTION OF CIviL MODEL

| WWW.BENTLEY.COM

TO INFORMATION MOBILITY

INTEGRATED PROJECTS

Work
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Content
Reuse

AECO
Information
Management

namic
lgayedback

EN
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© 2013 Bentley Systems, Incorporated

= Bentley

Sustaining Infrastructure



Learning Paths:

Ready-Made Training Plans

Choose from:

— Bentley recommendations
— Configure your own

* Organizational

* Personal

Select:

roduct(s) and version(s
anguage
raining type

Enroll team members in:

— One learning path
— Multiple learning paths
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Personalize Learning Path

Use this form to personalize a Leaming Path. You can enable/disable specific course
your Leaming Path. Cick the Help icon for more detaied instructions and a Step-By-Step guide.

Learning Path Type

Name*  Beiers custom ip

Description*

Courses

MicroStation Essentials |

MicroStation Essentials is designed for the new WicroStation user and buids a
found in the MicraStation drawing environment. Starting with setting

()

Title
) MicroStation Essentals
@ MicroStation Essentials Basics
@ MicroStation Essantiais Express
@ MicroStation Essentials
@  MicroStation for AutoCAD Users
@ MicroStation for AutoCAD Users Express
@ MicroStation for Mining and Metal Extraction
@ MicroStation for AutoCAD Usars Express

M4 » M

@ MicroStation Essentials Lecture Series

@ MicroStation Quick Start Guide

@  MicroStation Essentials

@  MicroStation for AutoCAD Users

MicroStation for Mining and Metal

@
Extraction

@  MicroStation Essentials

@ Personal Leaming Path

Language
Engish

English

Engish

English

English

English

Set as Company |

feings by expanding the "Find Training” tab. and even add new course biocks into

v8i

VBi

VeI

VBi

Vi

VEi

2+ F17 TrANg » PErSRITE Leaming Pam

Personalize Learning Path
Use this form to personalie a Learning Path. You can enable/disable specific course of ferings by expanding the “Find Training™ tab, and even add new course biocks into
your Leaming Path. Click the Help icon for more detaded instructions and a Step-By-Step guide.

Name®  \jeroStaton Technician in a Roagway Setting

Deseription® 5 yoar onboarding program. 72 LU's. Multiproduct MS, FW, InterPlot, InRoads. Live and on-demand seif-study. -

Learning Path Ty,

Personal Leaming Path @ Set as Company Leaming Path

Manage Master Course List

ProjectiVise User Essentials I
This course s for individuals who need to manage documents throughout 3 project cycle and work in the ProjectWise managed

environment. It presents techniques for working in the integrated environment... ) s
U
Tie Language Generaton  Release Label Lus
@ ProjectWise User Essentials Engiish Vai SELECTsenes 2 8
@ ProjectWise User Essentials Engish v8i SELECTseries 3 B
@ ProjectiWise Chent Start Up Guide Engish Ve Base Relase 4
@ Progctiise User Essentials Engish vei Base Release ]
Wl W oa 1] »om Displaying items 1- 4 of 4
Language Generaton Release Label s Type
@ Design Mansgement Studio Englsh vai Base Release 1 S::‘r"d eLeaming:
OnDemand elearning:
@ ProjectWise User Essentials Engish Ve SELECTseries 2 8
rojectiVise User Essen gl i seies e B
@ ProjestWise User Essentisls Engich VBi SELECTseries 3 g OnDemand eLeaming: B
Hands-on
OnDemand eLeaming:
@ Projectwise Client Start Up Guide Engish vai Base Reease 4 ~ B
Handson
OnDemand eLeaming
Pi tWe h Vi R
@ ProjectiWise User Essentials Engis! ] Base Rekease | bt B
+ @ ProgctWise User Essentials English vai Base Release 5 B
K E > ¥ Displaying items 1 -8 of &

MicroStation Essentials |
MicroStation Essantials is designed for the new MicroStation usar and builds 2 sobd foundation in the concepts, tools and features
found in the MioroStation drawing environment. Starting with setting.
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This Session’s Learning Path:

Here's the name and link to a short learning path that includes
this session and recommended modules that you may share with
your colleagues:

V8i (SELECTseries 3) OpenRoads Technology Learning Path

http://learn.bentley.com/app/Public/ViewLearningPathDetails?Ipl
d=104292#.UYkxZxK2r9s.email
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Questions?

Thank you!
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